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The Project Window

Projects are displayed in the Project Window.

F= Project Window >
Current Project: None Autosave: Every 5 minutes
Family Historian Projects | Last Updated |
Family Historian Sample Project 19/11/20 21:20

Location: My Documents\Family Historian Projects

Mew Project... Cpen Project More Tasks...

Exit Application Tips for Mew and Upgrading Users Help

CREATE YOUR FIRST PROJECT

Click here to create a project. You can start a new
one from scratch, or import a GEDCOM* file, or a
family tree file created by The Master Genealogist,
Roots Magic, or Genbox (most versions).

USE THE SAMPLE PROJECT TO TRY THINGS OUT
If you open the Sample Project, you can click ‘Close Project’
on the File menu to return here.

* GEDCOM is the global standard file format for shared genealogy data. Most genealogy programs will
allow you to export your data as a GEDCOM file.



The Focus Window

The main workspace window is the Focus Window, shown below with the Property
Box docked to the right, and the Navigation Bar (with Focus Window icon selected)
on the left.

[ Family Historian Sample Project - Family Historian Project - [Focus Window] - o x

/7 File Edit View Add Tools Intemet Window Help & x
= - @ == . . . .| )

H 48 2% = = ¥ I %83 d B

Save Home Focus Source Media | Ancs Descs  Both  Rels | Charts Publish Query Map | Property Find Up  Down | Auto

Customize View <_‘ ‘ @ ,_) j ‘ \5% Eﬂ é @'|

,\) lan S‘EP':;: MUNRO | B | & ! Individual: Tan Stephen MUNRO [6]
) e Mam\@ﬁm\ﬂmm\'\@mdia (B A

= Name: | Ian Stephen Munro more...
<= Spouses & Children \Parems&smlmgs \Ancssmrs \Dsscsndams ‘ & ‘
Sex: Occupation: | volunteer with Oxfam
AE MUNRO SIDOWLING  ACARRINGTON E HODGES B ‘ 5 Jan 1953 | n | Lewisham, London, England |
»~) 1922-1998 (aged ~) 1925-2008 (aged ~) 1924-1979 (aged ) 1936- (age: 84) ‘ | | |
Died: in
lan Stephen MUNRO Charlotte CARRINGTON Note:
Bom: 5Jan 1953 in Lewisha Born:  13Jun 1957 in Bath, 8 |:|
Age: 67 Age: B3
P Sings in a choir and plays the c. Spouse: | Charlotte &
Married: 12 January 1986 (ages: 33 & 28) in Midsomer Norton, Somerset. England " Name: ‘ Charlotte Carrington ‘ P
Children: 3 Sex Birth Death Rel i | Bon: [13Jun 1957 | in | Bath, Somerset, Englz
~ Christopher lan MUNRO M 12 Jan 1987 (age 9} Died: | Jin]
/ Janet Elizabeth MUNRO F 11Mar 1989 (age: .. A marr: [ 12120 1986 | in | Midsomer Horcon, sof
# Paula Charlotte MUNRO F 3Dec 1994 (age: 8] statue: | note:[mnons H
Add Child Charlotte v
Add More Relatives for lan Stephen MUNRO Children: 3 |Sex| Birth |Rel £[3]
Christopher Ian MUNRO M 12 Jan 1987 4
Janet Elizabeth MUNRO F 11 Mar 1989 4
Paula Charlotte MUNRO F 3 Dec19%4 13
Add Child
For Help, press F1 Individuals: 105 Families: 43

FOCUS WINDOW

Main workspace window. For PROPERTY BOX
viewing a given ‘focus person’ For data entry and
(in this case, lan Stephen update.

Munro) and their close relatives,

ancestors and descendants.

NAVIGATION BAR
For switching between workspace windows.




The Property Box: Docked...

Click-and-drag on ‘splitter bars’ to reshape the Property Box, and to resize it. The
Property Box can be docked at the side of the window (as shown below), or allowed
to ‘float’ in front of workspace windows (see next page).

[/l Family Historian Sample Project - Family Historian Project - [Focus Window] - O X

5%" @' 7 ’v [ﬂ

Charts Publish Query Map | Propety  Find

- File Edit View Add Tools Intemet Window Help

B & 2P &% @& ¥ = X ZE

Save Home Focus Source Media Ancs Descs Both Rels

-8 x

i
S

Up  Dawn | Auto

Customize View.

N
i S| PEIBa 2@
FE | 1 E ¥ Individual: Ian Stephen MUNRO [6]
1953~ | 4
LS Main \@ Facts \u Notes \@ Medba' EX

= Name: | Tan Stephen Munro more...
L] Spouses & Children \Parenm & Siblings \J\Ancesmrs \I\Descendams | P I ‘
AE MUNRO SIDOWLING  ACARRINGTON E HODGES Born: |5]an 1953 ‘ i ‘ Lemsham,ﬁndon, England |
) 1922-1998 (aged.. ) 19252008 (aged .. ,’ 1924-1979 (aged.. ) 1936 (age: 84) y 4
Died: | ‘ in ‘ I |
lan Stephen MUNRO Charlotte CARRINGTON Note: /
Bom: 5.Jan 1953 in Lewisha Born: 13 Jun 1857 in Bath. S. / D
Age: 67 Age: 63
7 Sings in a choir and plays the ¢ Spouse: | Charlotte | <
Married: 12 January 1986 (ages: 33 & 28) in Midsomer Norton, Somerset England i Name: | Charlotte Carrington I ‘ B
i y i
Children: 3 Sex Birth Death Rel i n: | 13 Jun 1957 I ‘ in ‘ Bath, Somerset, Eng\d
y i
» Christopher lan MUNRO M 12 Jan 1987 (age g Died: | [/ i |
~ JanetElizabeth MUNRO F 11Mar 1989 (age: . wmarr: |123an 1986 4 | in | Midsomer Norton, Sof
' Paula Charlotte MUNRO F  3Dec19%4 (age: .. - Status: -. Note:
Add Child Charlotte ¥
Add More Relatives for lan Stephen MUNRO children:3 4 |Sex| Birth [Rel.[ ¢[3]
Christopher IagfMUNRO M 12 Jan 1987 4
Janet Elizabeffl MUNRO F 11 Mar 1989 B
Paula Charlftte MUNRO F 3 Dec 1994 B
Add Child
For Help, press F1 / Infiividuals: 105 Families: 43

SPLITTER BARS
Click-and-drag on this
‘splitter bar' to move the
boundary between the Focus

FLOAT PROPERTY BOX

Click here to ‘float’ the
Property Box in front of

Window and the Property Box. a2 | B Ve o

Other splitter bars can be used
to move boundaries within the
Property Box itself.




...and Floating

Whether docked or floating, the Property Box (shown below, floating) displays
record details for the currently selected individual.

[l Family Historian Sample Project - Family Historian Project - [Focus Window] - O b

/7 File Edit View Add Tools Intenet Window Help - & x
=~ @er — i (=

B & ~ % = & X IE E i ) &

Save  Home Focus Source Media | Ancs  Descs  Both  Rels Charts Publish Query  Map \| Property / Find Up  Down | Auto

Customize View.

1953-
Root Person

IS Individual: lan Stephen MUNRO [6]

,\') lan Stephen MUNRO

<7 < | Spouses & Children \Parenls& Siblings <
Main \@ Facts . " Nof

*L,EBE@R 5{1{3¢)
IR TN HODGES

Note:

Anthony Edward MUNRO Susan y 4
e 1922-1998 (aged 76) A 182 | Name: | [ian Stephen Munro I | mo!.. (age: 84)
lan Stephen MUNRO Sex: | Male . %upat\on: | volunteer with Oxfam l |
Born: 5.Jan 1953 in Lewisham, London, England Born: [51an1953 /| in| Lewisham, London, England | I
e 67 y 4 ’ i
Died: | I ‘ m‘ ' |
y i

Married: 12 January 1986 (ages: 33 & 28) in Midsomer /

J
Children: 3 4 / / Rel
Spouse: | Chfirlotte >
[
/

~#/ Christopherlan MUNRO

7 Janet Elizabeth MUNRO Narne:lchar\otte Carrington ‘ B H
 Paula Charlotte MUNRO ‘ 13 Jun 1957 | in ‘ Bath, Somerset, England | n
[ / |
Add More Relatives for lan Stephen MUNRO g ‘ 12 Jan 1986 | in ‘ Midsomer Morton, Somer’et, England |
Status: Note: | Ian and Charlotte mgf in A
’ Bristol. She was a gudent at v
|
Children: 3 [sex/ Bith  Jf [Rel.[ +[3]
Christopher Tan MUNRO M 12 Jan 1987 4
Janet Elizabeth MUNRO F 11 Mar 1§89 B
Paula Charlotte MUNRO F 3 Dec1§94 4
Far Help, press F1 44 Child [
Add Chi

/

RE-OPEN PROPERTY BOX
If you close the Property
Box at any time, click here

DOCK PROPERTY BOX

Click here to ‘dock’ the
Property Box once again, at
the side.

to re-open it (or right-click
on an individual and select
‘Properties’).




Add Relatives in the Focus Window

Click on links (see blue ovals below) to add relatives of individuals showing in the
Focus Window. You can also add relatives, and unrelated individuals, by clicking

options on the ‘Add’ menu.

[ Family Histarian roject - Family Historian Project - [Focus Window] O X
/J File Edit Vi Add Jools  Internet  Window  Help - & %
= @ ZE v - = - | ==
d & S~ * = X E|ZS-F & 2 @ s
Save Home Focus urce  Media Ancs Descs Both Rels Charts  Publish  Query Map Property  Find Up Do Auto

,_) Michael Pledgance MUNRO

Grandfather of \an MUNRO

Customize View

Arthur Michael MUNI
vl . 1831-

1891§978
) Mary IMUNRO} Add Margaret's Father
% : :

Bom: c. 1865 in Glasgow, Lanarl
Died: 1943 (aged 77-78)

Born: 1866 in Florida, USA
Died: 1943 (aged 76-77) in Florida, USA

yel

Children: 3 Sex Birth Death

# lan Scot MUNRO M 3Jun 1885 18 Mar 1927 (aged 41)

Margaret PLEASANCE

Add Margaret's Mother

# John MUNRO 1887 1888 (aged 0-1)
| Michael Pleasance MUNRO W 1891 —— 210ct 1978 (aged 86-87) 2
Add Sibling for Michael
Add More Relatives for Michael Pleasance MUNRO
For Help, press F1 \ Individuals: 104 Families: 42

‘ADD’ MENU
Use it to add relatives of all

kinds, and unrelated
individuals.




Enter Details in the Property Box

Use the Property Box to enter details of the new person. This person was created
as the father of Margaret Pleasance, which is why she is already listed as a child.

<

L, -ELd2E(EHE

! Individual: PLEASANCE [124]

5 Facts )L [ Notes [ Media | E§ Al
NG

Name: | |,"Pleasar1r:s.~,Il \ | MOre...
Sex: m Dccupation:| \\ |
Born: | [in|

Died: | | inl

Note:

\\
Add Spouse/Partner

Margaret FLEASANCE 1866
Add Child

Marr: | | in| |

Status: v Note:

Children: 1 | sex| Birth Rel.| [+
b

ADD RELATIVES
You can click links to add relatives here
in the Property Box too — not just in the

Focus Window. Use whichever

technique is most convenient.

MAIN TAB
Enter basic information

(name, life dates, etc.)
on the Main tab

FACT TAB

Use the Facts tab to
enter more details,
and more facts
(events and attributes)

SPOUSE TABS

Pick the right spouse
tab when adding
spouses or children.
In this example, a
spouse added on the

first tab will be added
as the mother of
Margaret Pleasance. If
that's not what you
want, use the other
tab.



Cite Your Sources

REPRE (15 S Readl =] <

“! Individual: Michael Pleasance MUNRO

Main Facs | " Notes | [Z| Media | 5 Al
Name: | Michael Pleasancwu-—\ | Mmaore...
.
Sex: @upation: | Iawyed ) El
-
Born: | 1891 [T OTando, Florida, USA |

| in | Lewisham, London, England |

Died: | 21 Oct 1978

MNote: |A nephew of Ian Scott Munro, a famous railway engineer. 4 |
Michael appears to have been a favoured nephew of lan v

Spouse: = Catherine ar

Name: | Catherine Reardon | [

Born: | Q1 1895 | in | Cheltenham, Gloucester, Engla|

Died: | 18 Feb 1963 | in | Greenwich, London, England |

Marr: | 15 Jan 1915 | in| Florida, usa |

stots: o
Children: 4 |sex| Birth |Rel.[ [
Peter Michael MUNRO M 18 May 1920 o4
Anthony Edward MUNRO M 12 Jan 1922 o4
Julia Rosalind MUNRO F 5 May 1924 o4
Amanda Morag MUNRO F 15 Jun 1926 o4

Add Child
P
Sources ForQDccupation*)
N —
Citation (Text: Source Record) | Source Rec ﬂ 3
Birth Certificate: Amanda Munra 0 5 [8]
Birth Certificate: Anthony Munro o = [71

é?"onddcmionvr@% |I_L—Z x||@'|$

The Citation List pane is used to view and manage source citations.

SHOW SOURCES
Click the ‘Show
Sources’ button to
show or hide the
yellow Citation List
pane (below).

CITE YOUR SOURCES
The Citation List pane
lets you view a list of
source citations for
the current item of
data —in this case,
Michael Munro's
occupation as a
lawyer. Double-click
on any citation to
open the Citation
Window to view and
edit details.




Change the Focus Person

Double-click on any box in the Focus Window, or click on the little magnifying
glasses (circled in blue) to change the Focus Person (that is, the person shown at the
top — in this case, Susan Isabel Dowling).

m Family Historian S5ample Project - Family Historian Project - [Focus Window] - O x
- File it View Add Tools Internet Window Help -
= - @ IE ~ -~ =l - 2
H( & S @ |y = X I 5S-G & &2 @K
Save \_ Home J'Focus  Source o Descs Both Rels Charts  Publish  CQuery Map Property  Find
— Customize View
) Susan Isabel DOWLING |
1925-2008
Mother of lan MUNRO |
: <7 = _J) Spouses & Children \Parems & Siblings \I\Ancestors \Descendants
ichael P MUNRO C REARDON ichard DOWLING |, e 2
191\1978 (aged 86-8 195-1963 (aged 67-68){ ' PP117-1943 (aged 31)
nthony Edward MUNRO! Susan Isabgl DOWLING |
) !
Born: 1}4Jan 1922 in Cheltenham, Glou... Born: 25 Jan 1925 in Qrkney, Scotland
ied: 1998 (aged 76) in Bristol, En.. Died: Oct 2008 (aged §3) in S5t Pauls,..
jover of great outdoors, Anthony coul... ‘
arried: Octobey 1950 (ages: 28 & 25) in Redland, Bristol, England
Children: 4 Sex Birth Death Rel.
udy Susan MINRO F  15Sep 1951 (age: 69)
L Stephen MUNRO M 5Jan1953 (age 67) £
bally Theresa MUNRO F 27 Aug 1954 (age: 66) H
igel MUNRO M 7 Mar 1956 (age: 64)
Add Child
w
For Help, press F1 \ Individuals: 105 Families: 43

GO BACK /GO FORWARD
Click the Go Back button to
go back to a previous focus

person. Click Go Forward to
undo a ‘Go Back'.

10

THE HOME BUTTON
Click the Home button at
any time to revert to

showing your starting
person (called the File
Root) as the Focus Person.




Open a Diagram

Once you've selected the person who will be the diagram root’, click on a toolbar

button to open the diagram you want.

/] Family Historian Sample Project - Family Historian Project - [Focus Window]

- & %

7 File Edit View Add Tools Internet Win;

= = . - -
H & ~ 5 > = ¥ ¥ %
Save Home Focus Source Media ncs  Descs  Both  Rels | Charts gublish

- = 4l .
<3 i &
ry  Map | Property Find Up  Down | Aute

lan Stephen MUNRO
1953-
Root Person

o

Customize View.

&

¢ PRIEE2 & EE

#“' Individual: Anthony Edward MUNRO [1]

Main Facts | [7) Notes | [Z] Media

=

Name: |Amhony Edward Munro

| more (+)...

Richard DOWLING
2 19112-1943 (aged 31)

Michael P MUNRO
/2 1891-1978 (aged 86.

C REARDON
- 1895-1963 (aged 67.

Susan Isabel DOWLI

Children: 4 Death

+ Judy Susan MUNRO 15Sep 1951 (age: 69)

AN Susan’s Mother

[wale -]

Sex:

Born: | 12 Jan 1922 linc Glou

ter, England

Died: | Dec 1998 ‘ in ‘ Bristol, England

Note:

A lover of the great outdoors, Anthony could never ~
be persuaded to work in an office. He wasa keen v

Spouse:

ulia | Susan | % £
Name: | Julia Amanda Fish 3
Born: | 12Jan 1925 | in | Greenuiich, London, Er

Died: in
| [ n]

| 1anStephenMUNRO | 5 Jan 1953 (age: 67)

Marr: | 14 Feb 1947

M
/> Sally Theresa MUNR F 27 Aug 1954 (age: 66)
M

~ Nigel MUNRO 7Mar 1956 (age: 64)

| in | clifton, Bristel, England

Status: [¥]  mote: ‘The marriage ~
lasted less ¥

Add Sibling for lan Children |sex| Birth |Rel.[+]>
Add More Relatives for lan Stephl MUNRO Add Child
For Help, press F1 104 Families:42

FIRST SELECT DIAGRAM ROOT
Select the person you want to

be the root of the new
diagram — in this case,
Anthony Edward Munro.

11

THEN PICK A DIAGRAM
Pick one of the 4
standard diagrams
(Ancestors, Descendants,

Ancestors & Descendants,
All Relatives); or click on
‘Charts’ to choose from
many more.




The Diagram Window

Diagrams display in the Diagram Window, which is another workspace window. The
first workspace window was the Focus Window.

] Tony MUNRO] - o x
ZE Fie et View Add Toolf Disgram flintemet Window rielp
3E - v B2 - = - 0 = G -
> = X E (S-S & 2|2 & il ELC) o | % 0 & Q| & & M| K
s Descs  Both  Res | Chats Publih Quey Map | Propety Find | Us  Down | Auto fl Spouse Button Page Awoid | I Ouw | Ft  Ares  Opts | Comnect Move Select | Shapes
haries Wikam Smith MUNRO argarst PLEASANCE James REARDON Elca Katherne
Bom c. 1655 n Glsaou oo 068 Floe, USA Bom: 1679 n Chetennam, 8o 03 16781
Sedina Hiar-o. e n Finda, US4 ‘oucter Engand loucsser ol
Dest 1888 525 TofSn P, V54 De Do 01 eSS
ouceser Engand
Wichasl Plezsance MUNRO Catherne REARDON
Bom: 1651 nOtando,Fotds USA Som: Q1 1655 nChetenham,
B 21 outt &
a8 $an 191 mFloida USA
Bei taFen 63in
ationy Ecward WUNRO Susan sabel DOWLING Amand lorag WUNRO
Som: 18May P, oot Som: 12 1522 n Cretennam 8o 25 Jan 1525 m Oy Som: 15 1526 nCretennam,
USA ‘oind London Engna i Ergans a0 1950 nRedan. v oicrser trgars
Diea 1580 n et Aampsire, ar 15 <74 Fa 1847 Citon, Bt Da e ok n Bt Engana o33 bec 005 A arca, Usa
England Died: Oct 2008 in St Pauls, Bristol,
Judy Susan MUNRO lan Stephen MUNRO ‘Charlotte CARRINGTON Sally Therell MUNRO. f” E Nigel MUNRO
Som 15 Sep 1551 n Lowisham, Bom: 5 Jan 1983 nLeviaham, Bom: 13.un 1557 n Bt Somerset, o m
Londen, Engine Londen, Engand Londo, Enflind Condon, Engina
a3 1588 Uidsomeroton,
‘Someree engard
Crisophr an HUNRO. icola HEMMINGS JanetEiza g HUNRO Pauls Charotts MUNRO i reRRISON Emma WUNRO
Bom: 120 1567 inBath, Somenet, Bom: 11ar 1969 gl Englnd Som:3Dect694 n il Engand
erane
For Help press 1. o0

NAVIGATION BAR ICON
Note the new icon on the
Navigation Bar for the new
workspace window, marked
in orange to show that this is

NEW MENU & TOOLBAR
There's also a new
‘Diagram’ menu, and new
toolbar. They're only

there when the Diagram
now the active workspace

window. Click on any of the
icons on the Navigation Bar
to switch between the
different workspace windows.

Window is active. Some
of the other workspace
windows have their own
menus & toolbars too.

12



Interactive ‘Smart Trees’

Diagrams are interactive and use ‘Smart Trees’. They adjust immediately and
automatically as you make changes.

.

liam Smith MUNRO Margaret PLEASANCE i : Elda Katherine COLE
Bom: 1266 in Florida, USA 3

Mar: c. 1884 in Florida, USA

Died: 1343 in Florida, USA

Michael Pleass Catherine REARDOMN
‘Bom: 1891 in Oriando, ida, Born: Q1 1895 in Cheftenham,
Died: 21 Oct 1978 in Lvisham, Glo ucester,

Londen, England Mam: 15 Jan 1915 in Florida, USA
Died: 18 Feb 1963 in Greenwich,
London, England

DDISON Julia A 8 Anthony Edward MUNRO ' Susan |sabel DOWLING
in Liverpool, Bom: 12 Jan 1 i ich, Born: 12 Jan 1922 in Cheltenham, y Born: 25 Jan 1925 in Orkney, Scotland
London, % ‘Gloucester, England Marm: Oct 1950 in Redland, Bristol,
Marr: 14 Feb 1847 in Clifton, Bristol, Died: Dec 1998 in Bristol, England England
England Died: Ot 2008 in 5t Pauls, Bristol,
England

lan Stephen MUNRO ’ o Sally Theresa MUNRO
Bom: 5 Jan 1953 in Lewish | omgpeet, Born: 27 Aug 1954 in Lewisham, |J
Lendon, England ¥ | ’ England 5 Lon ngland |

SHOW/HIDE BRANCHES EDIT RECORD DETAILS

Click on ‘expansion’ Double-click on any box to open the
buttons to show or hide Property Box. Any changes you
branches. make appear instantly on the tree.

MOVING/RESIZING
Click ‘Enable Moving/Resizing’ on the ‘Diagram’ menu to
enable moving and resizing of boxes, branches, and more.

CLICK-AND-DRAG TO ADD RELATIVES
Click-and-drag on any box to add relatives. The rule is: if
the tree would show it, you can click-and-drag to add it.

13



Add Pictures

Click the Media button on the main toolbar to view pictures in the Media
Window — another workspace window. There are 9 workspace windows in total.
We only look at 3 in this guide.

‘ [ ) - o x
@) File Edit Vi s Medio Intemet Window Help _s
d @ r = X |59 & 8| = &« ol »| & = ] 11
Swe Home focu: Wouce Media | Ancs Deses  Both  Rels | Charts Publish Quey Msp |Propety Find | Up  Down | Auo | Loyout | Link | View |©) e n__ o stosize_Actual | Grabber_Play
| [y vedatit =
. I I
,) Meda List: oo
|| Keword Fiter:| (ofiiter) v
§< .
| | [MedaRecords . y
3 1871 Census RG99 123 Alan Carrngton Anna Munro_(Professional Anthony Munro Anthony Munro Hodges BACHelen-Mary-Addson
H 12345 Photograph)
3
H =
—
£l <
iges Ee=—=TEac] \
+—&) Caroline Amy Mo (Professional Photograph) — -

e -

sanet and Christopher H Bith Certicate lan Calum and Alex Hodges Calumand Alex Hodges Caroine Amy Munro Charies and Margaret
H Stephen Munro (Professonal Photograph) Hunro

nd family

: ] adch

Tan and Chariotte and Ian and Judy n the garden Ian Munro Tan Wiey and Family
famiy at Nantwich

By #

Elgabeth Hodges James Reardon and Edna
Cole

& Higel's irth

»
Fr]
& tigel and 0
& The Munros
& Wedding-Graham Munro)
< > |

For Help, press F1

=

Farniles: 22

‘ADD" MENU

VIEW FULL PICTURE
Click ‘Pictures’ on the ‘Add’

Double-click on any
thumbnail to view the full
picture (see next page).

menu to add pictures at any
time. They will be displayed
in the Media Window.

MORE WAYS OF ADDING PICTURES
You can add pictures in the Media tab
of the Property Box (see right).

You can also use drag-and drop, to drop
images onto the Media tab, or on to other
windows, to add them to the project.

14



Link People to Faces

Link each person to their face in each picture in which they appear. This is usually
done in the Media Window when viewing the full picture, using the ‘Links’ tab
(circled in blue below).

y 4
55y Media Ustl\t s Media Link Tool I @ Media Record (| == Links :’ Show Thumb)

Medalist: | Al Media
Keyword Fiter: | (no fiter)

[E=xiiey il Detai Note A
9] [Fma =] E N 1
| | [CARRINGTON, Charlotte

Media Records

2] MUNRO, Paula Charlotte

1871 Census R(D9 123 12345

Alan Carrington

Anna Munro (P}

bfessional Photog

Anthony Munro

Anthony Munro

odges Link Excluce From

BAC-Helen-Mary

Addison etz ‘

Birth Certificate|

lan Stephen Mun Use Link Note as Caption

Calum and

Calum and

Caroline Amy

T o
1 N
inro (Professional s w1 ey s -

Charles and Mol
[Charlotte, Paul
Elizabeth Hodg

jaret Munro b \ | / \ % el
g

it

Tan and Charlotf

and family ¥ N \ i u

Tan and Judy in

Tan Munro

Janet and Christs g { A < P
Ay
¥

Tan Wiley and F

e garden at Nan 2 A\ | ‘/. P Y
3 ' 2 {17 EE @/
mily H v = % 15y 1t

James Reardon

Janet Record

nd Edna Cole | |© ; ol Ya&= ¥ | 1 2, Ain’

Julia Fish

King Cambridge

Certificate M P P e [ - Wi I et

Marriage Certififiate - Tan Munro

Midsomer Nort

parish church

Nigel's Birthday

Nigel and Susal

Dowling . rs

The Munros

SOOIV UBTRT

Wedding-Graha)

Munro

ADD FRAME LINK

Click this button, then click-and-drag on the
picture to draw a stretchy ‘frame’ round the
face you wish to link to. You will be prompted
to select the face's owner from a list.

MEDI

is qui

A LINK TOOL -
The Media Link tool (enabled by toolbar button, right) B

cker and easier if you have several links to add.

15



Help! (how to get more of it)

Family Historian
provides detailed
help (over 500
topics with more
than 300 graphics)
for all aspects of
the program,
accessible from
the 'Help’ menu —
see example right.
In most contexts,
pressing the |E|
key will take you
straight to help
that is relevant to

(2 Family Historan Help

Hde

B e o &

Contents jpdex Search  Favourtes

EREEEE PE6 E6 OO0 SEOE6E

Vielcome To Famy Historan
What's New in Famiy Hetoden 77
Geting Sated

Notes on Upgrading o Version 7

Dragrand Drop.

Keyboard and House Shotcuts
Product Support

Glossary of Tems.

& @

&
Locate Back Fowl Fok Pt Options

Workspace Windows A

The Map Window

e

00|
g -l :
D

| T S

R

The Map Window (marked in red)

Theap Wi apene koo i ap oot 28 an e s, henyoucick i o a
‘dropdown menu appears with options. Allof the options will open a new Map Window If one isnit open already. If a Map Window is already open,
it will be re-used - unless you have specified in Preferences (Workspaces tab) that you do not want Map Windows to be re-used. The options are:

Map All Places Creates a marker saf (see next section) to map all Place records

Map Places for .. | Creates a marker set for the currently selected Individuals. The marker set will show, for each Individual, all

the places that they are associated with.

the current context. Or, if you can see a Help button, press it!

VIDEO TUTORIALS
There are numerous useful video tutorials at

www.family-historian.co.uk/su

ort/videos

THE FAMILY HISTORIAN USER GROUP
The Family Historian User Group website at www.fhug.org.uk

has forums, videos, a knowledge base, downloads, a wish list,
and much more. It is an essential free resource for all users.

JOIN THE COMMUNITY
Join Family Historian user forums, or subscribe to the
Family Historian Bulletins email newsletter. Details at

www.family-historian.co.uk/community
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